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Abstract:  Today, the new approach to pharmaceutical quality is called Quality by Design. The following paper 

provides an overview of pharmaceutical quality by design (QbD) and explains the various software tools and 

applications that are employed in QbD. The goal of pharmaceutical development is to create high-quality 

products and manufacturing processes that reliably produce the desired results. Products cannot be assessed 

for quality; instead, quality should be included into the design. The study analyses the current QbD-assisted 

software’s, such as    design- experts, Minitab fusion product development 

 

Index Terms - Quality by design (QbD), Minitab, Design of experiment (DOE), Modde®, Fusion QbD 

 

I. INTRODUCTION 

 

Quality by Design (QbD) is “a systematic approach to development that begins with predefined 

objectives and emphasizes product and process understanding and process control, based on sound 

science and quality risk management.” Quality by design (QbD) encourages the pharmaceutical industry to 

use risk management and science-based manufacturing principles to gain process and product understanding 

and thus assures quality of the product. With the objective to curb the rising costs for development and 

regulatory barriers to innovation and creativity, QbD is being widely promoted by Food and Drug 

Administration (FDA) and International Conference on Harmonization (ICH). Building quality into the product 

from the start is known as "quality by design" (process design stage). Being able to test and characterize your 

process or product to make sure it is reliable and stable is a key component of Quality by Design. Regulatory 

compliance, especially with regard to ICH-Q8 criteria, requires this. It is necessary to determine the proven 

acceptable ranges (PARs) or normal operating ranges (NORs) during process development, process 

characterization, or both. Final formulation development is a crucial stage in the drug development process. 

For patients to receive pharmaceutical goods successfully, each product is manufactured to a certain dosage. 

For the duration of the product's shelf life and during manufacture, a good formulation needs to remain stable. 

Furthermore, a scientific method to reduce process variation and boost productivity is called Quality by Design. 
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DOE Software for Quality by Design (QbD) and Process Optimization2 

For biopharma and pharmaceutical enterprises, commercial success and regulatory approval depend heavily 

on the early incorporation of quality into your goods. A key instrument for attaining both regulatory 

compliance and a quicker time to market is the Design of Experiments (DOE). DOE plays a vital role in 

assisting R&D and production.  

 

DOE can assist you in: 

1.Carry out process optimization.  

2.To determine process optimums, such as pH and temperature ranges that maximize a certain key 

performance indicator (KPI), choose the appropriate variables and ranges of process parameters. 

3.Verify and describe the robustness and stability of the process.  

4.Determine the critical process parameters (CPPs) that require control to provide robustness or that may be 

susceptible to slight changes in tiny factors.  

5.Observe and comply with regulations.  

6.Establish documented and repeatable procedures. 

Use the Quality by Design (QbD) methodology. Incorporate quality into your workflow in accordance with 

ICH Q8, Q9, and Q10.Enhance DOE-Based Experimentation Procedures 

The "one variable at a time" (OVAT) strategy, which is the conventional method of process testing, involves 

holding all other variables constant save for one. By using DOE, you can get a statistical analysis to determine 

the ideal operating parameters for a focused response. For instance, DOE can assist you in determining the 

impact of variables like pH, temperature, nutrients, speed, and flow rates (which are usually CPPs) on a 

particular process outcome or response, like the amount of product, patterns of glycosylation, or molecular 

size distribution (which are usually CQAs). The variables that affect an operation within a unit, such as a 

bioreactor, or across units, such as a step involving filtering and chromatography, are frequently highly 

complicated and interconnected. When navigating the investigation of cause-and-effect interactions between 

various parameters, DOE is a useful tool. Verify and Describe the Stability of the Final Product. Scientists 

can select the ideal formulation conditions by using DOE to create a formulation map, or design space, 

throughout the formulation development process. DOE-based formulation robustness studies can assist in 
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identifying QbD technologies like DOE offer a comprehensive view of the design space of a product. For this 

reason, using DOE studies to assess and describe formulation design space is quite advantageous. A data 

analytics technique called Design of Experiments (DOE) assists you in organizing, carrying out, evaluating, 

and interpreting controlled tests to ascertain which factors impact the stability, quality, or other important 

process attributes of your product. By adjusting several parameters at once, DOE expedites the process and 

aids in the identification of significant interactions, as opposed to experimenting with one parameter at a time. 

The DOE is in favor of the quality by design (QbD) method of product development, which is recommended 

by regulatory bodies. You may be sure that your formulation is resilient and that the quality of your finished 

product is high if you incorporate experiment assurance and reproducibility into your process. 

Time to Market is accelerated using MODDE® Design of Experiments Software3  

Modde® allows you to:  

1. Determine the outside bounds of your experimental requirements as soon as possible.  

2. Make a design area that is more accurate by using wizards and design templates.  

3. Determine their liable design based optimum for quality. Arrange complementary and subset designs.  

4. Examine every potential combination (complete factorial design). 

5. Describe the fractional factorial portion of combinations that will work.  

Differentiating itself from other DOE software products, MODDE® considers your specific goals and 

priorities. Alternatives are automatically assigned a risk assessment by intelligent quality-analytics based on 

decision about the acceptable level of uncertainty.4 An introduction to experiment design is provided in this 

two-day program. One of the main principles of the design of experiments technique is the construction of 

efficient experiments, or the extraction of the greatest amount of information from a limited number of 

individual experimental runs. In this introductory course, special emphasis is placed on the practical aspects 

of designing and interpreting experiments. In addition to blocked and screening patterns, fundamental two-

level designs will be covered. You are able to identify the key components and reveal how they interact. We’ll 

discuss statistical confidence so you can make more reliable judgments about the results of your experiments. 

Using real-world data, you will create and analyse step-by-step sample designs based on Design Expert.  

Developing statistical models that depict the link between causes and responses as a response-surface is a 

component of the process. The user can determine the necessary factor spaces that provide the highest yield 

for the process by using these models. A fantastic tool for these kinds of issues is Design Expert. You will 

learn more about the program and how to utilize it as part of this course. 

The FDA advises using Quality by Design (QbD) while developing new pharmacological substances and 

products. Finding factor-spaces that confer the required drug substance/product attributes is the fundamental 

principle. Modifying the production method within a design space after it has been approved is not regarded 

as a change. In this sense, quality by design provides exceptional flexibility in the creation of pharmacological 

substances and drug products. 
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The fundamental concepts of design of experiments (DoE), the cornerstone of any methodical search for a 

design space using the statistical program design expert, are covered in this seminar. Find out which kind of 

designs address which key questions. The entire course mirrors the entire process of developing a 

pharmaceutical product and is based on an FDA example.  

 

Design-Expert provides with the newest technologies in an extremely user-friendly setting for multi-factorial 

data analysis and experiment design. Design Expert gives you the ability to map difficult tasks in a "simple" 

experimental design and guides you through the traditional stages of screening, optimization (RSM), and 

validation. As a result, Design Expert enables to create new products faster and with lower costs while 

maintaining optimal process parameters. 

This covers optimization of chemical formulations or mixture designs, as well as integrated designs that 

address mixture and process factors in a single experiment, including so-called hard-to-change factors (for 

split-plot designs). 

The rotatable 3D plot is provided by Design-Expert. It facilitates the visualization of "response surfaces." The 

numerical optimization function is used to get to the optimal result. There, the ideal factor configurations are 

chosen concurrently. Multivariate optimization is managed by the optimization platform, which permits the 

optimization of several goal values at once, for instance. As a result, disputes arising from target variables can 

be resolved. 

Step 1: Installation and Setup4 

Download and Install: Obtain the installation file from the Sartorius Stedim Data Analytics website using 

the link provided in your delivery letter. Ensure have administrative privileges on your computer. 

Activation: After installation, activate MODDE either through the internet or by importing a license file, 

depending on your setup requirements. 

Step 2: Understanding Experimental Design 

Familiarize with QbD Principles: Understand the core concepts of QbD, which include defining Quality 

Target Product Profiles (QTPPs) and Critical Quality Attributes (CQAs). This foundational knowledge is 

essential for effective experimental design. 

Explore the User Guide: Review the user guide, particularly Chapters 1-3, which cover the basics of using 

MODDE, the experimental cycle, and how to design an experiment. 

Step 3: Designing Experiments 

Define Objectives: Clearly outline experimental objectives, including what aim to achieve with product or 

process. This may involve identifying the QTPPs and CQAs relevant to study. 

Use the Design Wizard: Utilize the Design Wizard in MODDE to set up experiment. This tool guides through 

defining factors, levels, and responses, ensuring a structured approach to experimental design. 

Select Design Type: Choose the appropriate design type based on objectives, such as factorial design, response 

surface design, or mixture designs. MODDE offered various customization options to suit specific needs. 
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Step 4: Running Experiments 

Conduct Experiments: Execute the designed experiments while adhering to the defined parameters. Ensure 

accurate data collection for analysis. 

Data entry: Input the collected data into MODDE for analysis the software provides tools to visualize and 

interpret the results effectively. 

Step 5: Analyzing Results 

Utilize the Analysis Wizard: After data entry, use the Analysis Wizard to perform statistical analyses. This 

feature helps in understanding the relationships between variables and their impact on CQAs. 

Interpret Results: Assess the output from MODDE, focusing on how different factors affect the quality of 

product. Use the insights gained to refine process or formulation. 

Step 6: Optimization 

Optimization Wizard: Employ the Optimization Wizard in MODDE to identify the optimal conditions for 

process. This tool helps in balancing different objectives while minimizing risks. 

Risk Assessment: Incorporate risk assessment tools available in MODDE to evaluate the potential impacts 

of variability in process parameters on product quality. 

Step 7: Documentation and Continuous Improvement 

Generate Reports: Use MODDE's report generation features to document findings and experimental setups. 

This is crucial for compliance and future reference. 

Update Knowledge Base: Continuously update knowledge base with insights gained from each experiment. 

This practice supports ongoing improvements in product development and process optimization. 

To install and activate MODDE after purchase, locate the delivery letter and follow the steps described below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Download the installation file from the Sartorius 

Stedim Data Analytics web page www.umetrics.com 

using the link in the delivery letter. (Without the link 

the downloading is more cumbersome and includes 

entering name, address etc.) 

Open the file and enter personal information as well 

as product information found in the delivery letter. 

If you want the Audit trail to be automatically turned 

on and locked, select the Force using Audit trail to 

log investigation events check box. After completing 

the installation, MODDE needs to be activated 
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Activation is done either 

(a) Over the internet automatically  

(b) By finding and downloading a license file following the directions in the message boxes 

(c) From an internal license server or  

(d) Importing a license file from Sartorius Stedim Data Analytics. Option (d) should only be used in situations 

where activation according to (a) and (b) is not possible. See the delivery letter, sent to the license 

administrator at company, for instructions.  

 

Experimental cycle 5 

The experimental cycle consists of three phases:  

1. The design phase where define factors and within which ranges they should be varied, your responses, 

objective, design and model.  

2. The analysis phase where explore your data, review the raw data and the fit, review diagnostics in plots and 

lists, refine and interpret the model.  

3. The prediction phase where use the model to predict the optimum area for operability. 

Design phase on the file tab, click new, and then click experimental design to open the design wizard. The 

Design wizard will guide through defining factors, responses, objective, constraints, and other information. 

Once have completed experiments, fill in the response data in the worksheet and change the factor settings as 

needed. Analysis phase After the response values have been entered in the worksheet review the raw data, fit 

the model, review the fitted model, interpret the model, and refine the model. The Analysis wizard on the 

Home tab can help guide through this phase. 

Explore the data to explore the unfitted data use the Worksheet tab. Plots and lists available are the curvature 

diagnostic plot, scatter plot, histogram plot, descriptive statistics list, correlation plot and matrix, and the 

replicate plot. 

Evaluate the design the condition number is used to evaluate the goodness of the design. As a rule of thumb, 

the condition number for screening designs should not exceed 3. For RSM designs it should not exceed 10. 

Fit when you are ready to fit a model to your design, click Fit model on the Home tab. MODDE automatically 

fits using MLR when the condition number is low and there are no mixture factors. The fit methods available 

are MLR, PLS and, if using mixture (formulation) factors, Scheffé MLR is also available. Review the fit using 

plots and lists After fitting the model, the summary of fit plot is displayed summarizing the fit in four columns, 

R2, Percent of the variation of the response explained by the model. R2 overestimates the goodness of fit. Q2: 

Percent of the variation of the response predicted by the model according to cross validation, and expressed 

in the same units as R2. Q2 underestimates the goodness of fit.  
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Model Validity: A Measure of the validity of the model when the Model Validity column is larger than 0.25, 

there is no lack of fit of the model (the model error is in the same range as the pure error).  

Reproducibility: The variation of the response under the same conditions (pure error), often at the centre 

points, compared to the total variation of the response. 

Diagnostics MODDE has a number of diagnostic plots, for instance residual plots to find outliers, drifts, trends 

etc. 

1. Box-Cox plot to select the best transformation of Y.  

2. ANOVA, Analysis of Variance, in particular review the lack of fit.  

The estimation of lack of fit is only available when there are replicated points as it compares the pure error 

and the model error. Interpret the model to interpret the influence of terms on the model use the Coefficient 

and Effect plots and lists. The interaction plot is particularly useful if model has strong interaction terms. To 

display the interaction plot, on the Analysis tab, in the model interpretation group, click Interactions. 

When PLS is used for regression, scores and loadings can be plotted. These plots provide an overview of the 

data. On the Analysis tab, click PLS to select the score or loading plot you want to display. Refine the model 

If you discover bad outliers or want to remove or add a term to the model can refine model. To remove outliers 

or insignificant model terms use the interactive exclude tool. Click exclude and then click/mark the 

outlier/term in a plot. You can also exclude it in the worksheet, right-click the specific cell and click Exclude 

values. The model is automatically refitted.  

Note: When excluding an outlier or model term in a plot, the outlier or model term is only excluded for the 

displayed response. You can add and remove terms from/to the model that are insignificant/significant for all 

responses, on the Home tab, in the Model group, click Edit model. To edit a common model for all responses, 

set the For-response box to all responses. After refining model, should once more review the fit and 

diagnostics to a compiled HTML file. To read the help file internet explorer must be installed but does not 

need to be default browser. MODDE help file is installed at the same time as MODDE and includes interactive 

help throughout the program.  

To open MODDE's help: 8 

1. Click Help in a dialog box or wizard. 

2. Click the help icon in the top right corner of the MODDE window.  

3. Press F1 On the File tab, click Help, then click View help 
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Registration and activation 

To register and activate, follow the installation instructions in the downloaded package.To register later, on 

the File tab, click Help, then click Manage license. 

Sartorius Stedim Data Analytics 

If have an Internet connection, can visit the web page of Sartorius Stedim Data Analytics 

(www.umetrics.com) to get the latest news and other information. 

On the File tab, click Help, then click Sartorius Stedim Data Analytics to visit the    web page. 

About MODDE 

To find license information and the version number of MODDE, on the File tab, click 

Help using MODDE ribbon description MODDE's ribbon interface follows the standard guidelines that 

Microsoft recommends. The nomenclature explained here is used throughout the help guide for  explaining 

where functions 

File tab -A menu of commands that involve the entire investigation or the active window, such 

as file-related commands. 

Quick Access Toolbar - A collection of icons, located on MODDE's title bar, that provides shortcuts to 

commonly used commands. Users can add icons to this tool bar or remove them. 

Group - A rectangular region on a tab that contains a set of related controls and commands. In the example 

above, the group's name is the Quick start group. 

Menu - A list of functions that shows up when a button is clicked 

 

Split button -A split button is a button that completes two different actions depending on where the user clicks. 

Clicking the top half of the button with the image opens the most commonly used item in the gallery, or a 

wizard that can create any of the gallery items, while clicking the arrow under the button opens a gallery or 

menu offering more choices. 
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Contextual tabs - Tabs that are only displayed under certain circumstances. An example of this is the 

Optimizer tab that only appears after clicking Optimizer on the Predict/Home tab. 

Gallery - A rectangular window that presents an array or grid of visual choices to aKey 

assignments can be modified as desired in the Options dialog, Keyboard page. 

MODDE SPECIFIC KEYBOARD SHORTCUTS 

1. Open the Design wizard: Ctrl+W  

2. Open the Analysis wizard: Alt+W  

3. Add to favorites: Ctrl+D 

4. Add to report: Ctrl+R 
5. Properties: Alt+Enter 

 

Investigation 

Experimental plans in MODDE are organized into investigations. Think of an investigation as a file folder 

containing all of the information related to a particular experiment. When select or open a given investigation 

can access, display and use all of its information. This information is organized in the following components- 

factors, responses, constraints, inclusions, candidate set, model, design, worksheet, analysis, predictions, 

optimizer, audit trail, notes, and design space. 

 

MANAGING INVESTIGATIONS 

Investigations are binary files saved by MODDE with the extension map can create new, open, and save 

investigations double-click a MODDE investigation in Microsoft Explorer, to open that investigation. 

MODDE does not save the fitted model. In order to review the results of the analysis and use make 

predictions, need to fit the model by clicking Fit model or have Automatic fit turned on (default) in File | 

Options, MODDE options, when the investigation is opened. After the model has been fitted, can open plots 

and lists to review the model and fit and create prediction plots and lists. 

COMPATIBILITY WITH OLDER MODDE VERSIONS 

All investigations from MODDE 9 and upwards can be opened in this version of MODD (the reverse is 

not true). 

MODDE supports:  

Full factorial, fractional factorial, general subset designs, L- designs, placket Burman, rechtschaffner, onion, 

D-optimal designs, reduced combinatorial designs, definitive screening designs, stability testing designs, ands 

RED-MUP for screening experiments. 

 user. 
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Key Applications of MODDE® in QbD 

Design of Experiments (DOE): 

MODDE® is primarily a DOE tool that allows researchers to systematically plan and execute experiments. 

This structured approach helps in identifying critical quality attributes (CQAs) and their relationship with 

process parameters, which is essential for QbD. 

Process Understanding: 

The software aids in gaining a deep understanding of how material attributes and process parameters affect 

product quality. By analyzing experimental data, MODDE® helps in establishing the link between these 

variables and product performance, which is a cornerstone of QbD 

Risk Assessment: 

MODDE® incorporates risk assessment features that allow users to evaluate uncertainties in their processes. 

This functionality is crucial for identifying potential failure points and ensuring that the design space remains 

within acceptable limits, thereby enhancing product reliability. 

Optimization: 

The software provides tools for optimizing processes, allowing users to find the best operational settings that 

meet quality targets while minimizing costs. This optimization is essential for achieving the desired quality 

outcomes in a cost-effective manner 

Design Space Calculation: 

MODDE® facilitates the definition and visualization of design spaces, which represent the ranges of input 

variables that ensure consistent product quality. This feature is particularly useful for regulatory submissions, 

as it helps in demonstrating that the product can be manufactured reliably within specified parameters. 

Guided Workflows: 

With built-in guidance and automated routines, MODDE® simplifies the experimental design process making 

it accessible even for users without extensive statistical expertise this ease-of-use accelerates the 

implementation of QbD principles across various stage of product development. 

Documentation and Compliance: 

The software generates comprehensive reports that document the experimental process and results, which is 

vital for compliance with regulatory standards. This documentation supports the transparency and 

reproducibility of the QbD approach in pharmaceutical development. 

 

MINITAB6 

The statistics program Minitab was created in 1972 at Pennsylvania State University by researchers Barbara F. 

Ryan Thomas A. Ryan Jr.and Barin L Joiner. It started off as simplified version of nist's omni tab 80 statistical 

analysis application. Minitab is a statistical analysis program that is interoperable with other Minitab llc 

programs and automates calculations and graph building, freeing the user to concentrate more on data analysis 

and result interpretation. Minitab is not for all types of users. It is specially designed for the six sigma 

professionals. Minitab is a data analytics software which delivers statistical analysis, visualizations, predictive 

and improvement analytics to enable data-driven decision making. Regardless of statistical background and 
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programming skills, organizations can use Minitab to analyses small and large datasets for quality improvement, 

process validation, product development and so forth. 

Role of Minitab in QbD7 

Minitab supports the QbD approach through its robust statistical tools, particularly in the Design of 

Experiments (DoE). This functionality is crucial for identifying and optimizing the factors that influence 

product quality.  

Key capabilities of Minitab in this context include 

Screening Designs: Helps identify significant factors affecting quality. 

Response-Surface Designs: Assists in finding the optimal conditions within the design space. 

Statistical Analysis: Provides tools for hypothesis testing, regression analysis, and capability studies, which 

are essential for validating the manufacturing process and ensuring product quality. 

Benefits of Using Minitab for QbD 

Comprehensive Statistical Tools: Minitab offers a wide array of statistical methods that facilitate the 

analysis of complex data sets, enabling users to make informed decisions based on empirical evidence. 

User-Friendly Interface: The software is designed to be accessible for users with varying levels of statistical 

expertise, making it easier to implement QbD principles across teams. 

Enhanced Data Visualization: Minitab provides advanced graphical tools that help in visualizing data trends 

and relationships, which is vital for understanding the impact of different variables on product quality. 

Integration with Risk Management: Minitab's tools can be integrated into risk assessment processes, 

allowing for continuous monitoring and control of critical quality attributes throughout the product lifecycle. 

Minitab offers several quality tools to help explore and detect quality problems and improve process in an 

objective, quantitative way to improve quality, common goals should include reducing defect rates, 

manufacturing products within specifications, standardizing delivery time and so on. 

Quality tools which are available on MINITAB.9 

Pareto Chart 

It helps to identify process problems which are most common by plotting the frequencies and corresponding 

percentages of a categorical variable. Pareto chart used to identify the most frequent defects, the most 

common causes of defects, or the most frequent causes of customer complaints. The purpose of this chart is 

to highlight the most important among a set of factors which is affecting the process so that can focus, 

improvement efforts on areas where the quality improvement can be made to great extent. 

Cause-and-effect (Fishbone) Diagram 

It helps to brainstorm potential causes of a problem and visualize relationships between a problem and 

potential causes. Sometimes there is a variation in a process but don’t know what the root cause of it. So, for 

this very purpose, can create a Fishbone diagram and compare the correlative importance of different causes. 

This diagram can be used in any type of industry whether it can be manufacturing, service, medical research 

and so on. Also customize the categories of causes according to requirements. 
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Process Capability Analysis10 

It helps to understand whether process is capable or not of meeting required specifications and provides 

insights into how can improve a poor process. To perform the process capability analysis, must mention 

specification limits (lower, upper or both) and compare the spread of the process variation to the range of the 

specification limits. When a process is capable, the process spread lies within the specification spread. It also 

indicates whether the process is on target or not. 

Measurement system analysis (MSA) 

MSA helps to find variation due to measurement system itself and guide to evaluate the consistency and 

accuracy of operators. A Measurement System Analysis is a critical component for any quality improvement 

process. So, it is always the first priority to evaluate measurement system before using control charts, 

capability analysis, design of experiment, or other analyses, to prove that the measurement system of the 

process is accurate and precise and hence can clarify that the data are reliable for making a decision. 

Acceptance Sampling 

It helps to evaluate the quality of incoming or outgoing products, based on certain quality characteristics. 

Acceptance Sampling is an alternative to 100% inspection and is a major component of the quality control 

process. Here, inspection is performed on a lot or batch of parts or products. Use acceptance sampling to 

accept or reject a lot based on a representative sample. 

Features of Minitab11 

1.Analysis of measurement systems 

2.3D graphs with contours and rotations 

3.Variance analysis  

4. Regression both linear and non-linear regression using nominal and binary variables  

5. Analysis of measurement systems  

6. Right-left exact failure and interval-censored data  

7. Generator of random numbers  

8. Accurate chi square fishers and other tests 

Minitab Learning: 

Similar to Microsoft Excel, Minitab provides users with training support. However, learning Minitab is not as 

simple as learning MS Excel. This is because Minitab is popular among Six Sigma specialists. Officially, 

Minitab provides customers with a wide range of courses, which are separated into two categories 
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manufacturing and services, for example in addition, Minitab offers public and onsite training. In addition, it 

provides its users with online learning. Excel is beaten by Minitab at this point of comparison, it provides 

users with excellent support in the form of a range of online resources. Download the documentation, the data 

set, and extra tools for Minitab videos webinars FAQs on license and activation for software updates on 

installations and blogs Minitab has many functions because it is used in educational settings in small, medium, 

and even large businesses. Additionally, Minitab offers a variety of work options, although proficiency with 

Minitab is required. 

FUSION QBD12 

Fusion QbD Product Development is quality by design software that enables non-statisticians to successfully 

implement quality by design (QbD) approaches. It is intended for scientists and engineers. Regulators (ICH, 

FDA, MHRA, etc.) have been pushing hard for the pharmaceutical industry to embrace quality by design. 

Design of Experimentation (DOE), multi-variant analysis, and mathematical modelling are the cornerstones 

of QbD methodology. The scientific community is challenged by this since they are not trained statisticians 

but rather experts in their own domains (such as formulation, analytical, or synthetic chemistry). The 

pharmaceutical industry differs greatly from the mathematical community in that GMP and 21 CRF Part11 

regulations are not applicable. As a result, general statistical programs that don't follow these guidelines 

include Design-Expert, to mention only one. 

Product Development for Fusion QbD is unique. With an automatic experiment design wizard and an easy 

user interface that guarantees the use of statistically valid designs, it keeps the user in their comfort zone. 

Testing templates are useful for arranging data from intricate experiments, such research on cascade impaction 

and disintegration. This helps the automatically generated necessary sequences to be used in the verified data 

exchange with chromatographic data systems. After that, the resulting raw CDS data may be imported again 

into Fusion QbD, where sophisticated data treatment methods can be used to transform the raw data into terms 

that can be modelled. The "must have" feature is completed by a collection of tools for compliance with 21 

CFR Part 11, which makes Fusion QbD Product Development the best quality by design software for drug 

development operations involving oral, topical, parental, and respiratory products. Fusion QbD is a quality 

by design tool that organizes trials and converts unprocessed data into knowledge by integrating with 

Chromatography Data System (CDS). Fusion QbD is the best QbD software option for all of development 

tasks thanks to its Design of Experiment (DOE) capabilities, CDS integration, GMP compliance and 

integrated-intelligence. 

 

There are modules available for developing HPLC methods, validating analytical methods, developing 

products or processes, and testing inhalers. Traditionally, these duties have required the employment of 

several software products, none of which are integrated with the others. Despite the significant amount of 

time spent on transcription checks, this leads to massive amounts of data being manually transcribed from one 

software product to another and constitutes the largest single cause of quality concerns. 

Additionally, programs like Excel, CITDAS, or generic statistical tools that are not compliant with 21 CFR 

Part 11 are frequently used to carry out the necessary computations and reporting. Data traceability and 
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integrity are raised by this. These problems are eliminated by Fusion QbD since all operations are carried 

out in a compliant setting. Fusion QbD increases quality and compliance while saving time and money. 

Key Benefits:13 Converts QbD Guidelines into Workable Tools That Professional Scientists and engineers 

can use assesses and controls risk in line with 21 CFR Part 11To put it briefly, Fusion Product Development 

is an all-inclusive software platform for quality-by-design that assists biotech and pharmaceutical businesses 

in applying the concepts of QbD methodically to every stage of the product lifecycle, from initial development 

to commercial production. It is ideal for industries that are subject to regulations due to its close integration 

with CDS and compliance features. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Auto-chrome MDS14 

Auto chrome DS emphasizes quality in its product sourcing capabilities. It allows users to access a wide range 

of products from reliable suppliers, ensuring that the items meet specific quality standards before they reach 

customers. The platform’s Auto DS Warehouse and Private Suppliers feature ensures that products are 

vetted for quality, which is crucial for maintaining customer satisfaction and brand reputation. 

Conclusion: 

In conclusion, the overall effectiveness, precision, and efficiency of the design and manufacturing processes 

are improved by the employment of various software in Quality by Design (QbD) techniques. Utilizing 

specialist technologies for risk assessment, process optimization, and data analysis, businesses can make sure 

that quality is integrated into the product from the beginning instead of being checked at the end. Better 

documentation, more effective team communication, and more exact control over variables are all made 

possible by software solutions. By enabling real-time monitoring and offering insights into process 

performance, they also support continuous improvement. In the end, including different software tools into 

QbD frameworks promotes creativity and raises the caliber of products, which increases customer happiness 

and lowers costs in addition to helping to comply with regulations. 
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